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Thank you for purchasing watchX
watchX is a multi-purpose wearable development board that anyone can develop.

 It can be used as a watch. it's compatible with Arduino/Scratch/Atmel Studio programming interfaces
so that users can program the watchX into a completely new device. 

From gaming to health monitoring, watchX can be used for development of new wearable applications.

This manual is designed to give you an introductory information about watchX.
You can find information about how to assemble, and program your watchX in the following pages.

however,

The material in this manual is for informational purposes only. 
The products it describes are subject to change without prior notice, due to the

argeX’s continuous development program.

argeX makes no representations or warranties with respect to this manual 
or with respect to the products described herein.

argeX shall not be liable for any 
damages, losses, costs or expenses, direct, indirect or incidental, consequential or special, arising out of, 

or related to the use of this material or the products described herein.

© 2018 argeX. All rights reserved.
watchX® and argeX® names and logos are trademarks of argeX.

www.argex.io

Other company and product names mentioned herein may be trademarks of their respective companies.
Every effort has been made to ensure that the information in this manual is accurate. 

argeX is not responsible for printing or clerical errors.

It is forbidden to 
modify, print, publish or distribute this document in the digital or physical environment

without the permission of argeX.
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Chapter-1 Assembling the watchX
 Box contents

 The watchX kit comes with the parts listed below;
 1- watchX PCB
 2- Oled display
 3- LiPo battery
 4- Long double-sided tape
 5- Short double-sided tape
 6- USB cable
 7- Nato strap
 8- Quick start guide

 Assembly steps

 Before you begin to use your watchX, you must go through some assembly steps.

1 2 3 4

5 6 7  8

remove the
protective cover of the
long double sided tape

1 2

stick the tape
on the drawn area

of the PCB
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9 10

11 12

13 14

3 4

5 6

7 8

unlock the FFC
connector locking latch

guide and insert
the Oled FFC cable

as shown

lock the FFC
connector locking latch

remove the other
protective cover of the
long double sided tape

stick the Oled
on to the tape carefully

remove the
protective cover of the

short double sided tape

stick the tape
on the back of the

PCB

connect the
LiPo Battery to the

connector located on PCB

you can disconnect 
the LiPo Battery 

as shown

remove the other
protective cover of the

short double sided tape

stick the
LiPo Battery

on to the PCB carefully

put on the
Nato-Strap
as shown
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15

plug the USB cable
and start charging and

programming!

 After finishing the assembly, your watchX is ready to use. You can use the watchX as a regular
wristwatch or you can unleash your imagination and develop your own applications with watchX.

 Your finished watchX assembly should look like the figures below;
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Chapter-2 Get to know watchX
 What is watchX?
 

 watchX is an Arduino & Scratch compatible wearable development platform. It is basically an 
Arduino Leonardo development board with lots of supporting components that can be strapped to your 
wrist. You can wear the watchX as a regular wristwatch or you can program your own custom applications
and take them anywhere you like. The device is so powerful and flexible that even we can’t put a
full definition to it. It is basically what you imagine and what you wish to do with it.
 We can’t wait to see what you will make with watchX. On your journey, we will be by your side
to support your projects with our educational materials that you can download from our website.

 Have a clooser look

1

2

4

3

5

Front

6

Back

1- Micro USB Port
2- Button 1
3- Button 2
4- Button 3
5- Oled Display
6- LiPo Battery
* Reset button is located 
under the top-right side of 
the Display
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 Charging the battery
 
 The watchX has a charging IC, this means that
you can charge and program your watchX at the same
time. Just connect the watchX to a USB power source
as shown in the figure. Once the watchX is connected to
a power source, it disconnects the battery and continues 
it’s operation with USB Power. This means the watchX 
saves battery life and reduces stress on it.
 If you are using watchX with it’s original firmware,
you can check it’s status about charging and battery status
from the icons listed below;

 Technical Specifications
 
 The watchX is designed to deliver the best programming experience. In this section, we are going
to have a detailed look at the components of watchX. Let’s start with the dimensions and carry on with
electronic components.

Battery Status

USB Connected

Charging

WARNING!
Always charge your watchX® with the original USB Programming and Charging cable.
Do not attempt to charge your watchX® if;
- The charging cable is damaged
- watchX® is wet
- watchX® is damaged
- The battery is deformed or punctured
It is recommended to use a regular cellphone wall charger or your computer’s USB Port

37.5 mm 11.1 mm

38
 m

m
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 PCB Layout

Front

Reset Button

General Purpose LED

Accelerometer / Gyroscope
MPU6050

Barometric Pressure Sensor
Temperature Sensor

BMP280

3 Axis Magnetometer
MAG3110 or MLX90393

Bluetooth
NRF51822

Back

Real Time Clock
DS3231M

SMD Buzzer

Voltage Regulator

MCU
Atmega32U4

Charging IC
MCP73831

FFC Oled Connector
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 Component Specifications

MCU Atmega 32U4
Features
- USB 2.0 Full-speed/Low Speed Device Module with Interrupt on 
Transfer Completion
     - Complies fully with Universal Serial Bus Specification Rev 2.0
     - Supports data transfer rates up to 12Mbit/s and 1.5Mbit/s
     - Endpoint 0 for Control Transfers: up to 64-bytes
     - Six Programmable Endpoints with IN or Out Directions and with 
     Bulk, Interrupt or Isochronous Transfers
     - Configurable Endpoints size up to 256 bytes in double bank mode
     - Fully independent 832 bytes USB DPRAM for endpoint memory
     allocation
     - Suspend/Resume Interrupts
     - CPU Reset possible on USB Bus Reset detection
     - 48MHz from PLL for Full-speed Bus Operation
     - USB Bus Connection/Disconnection on Microcontroller Request
     - Crystal-less operation for Low Speed mode
Program Memory Type Flash
Program Memory (KB) 32
CPU Speed (MIPS) 16
RAM (bytes) 2,560
Data EEPROM (bytes) 1024
Digital Communication Peripherals 1-UART, 2-SPI, 1-I2C
Capture/Compare/PWM Peripherals 2 Input Capture, 2 CCP, 12PWM
Timers 2 x 8-bit, 2 x 16-bit
Comparators 1
USB (ch, speed, compliance) 1, Full Speed
Temperature Range (C) -40 to 85
Operating Voltage Range (V) 2.7 to 5.5
Pin Count 44

Bluetooth NRF51822
The watchX is equipped with Raytac MDBT40-P 
(PCB Antenna)  which includes Nordic nRF51822 
Features
- Ultra low power consumption
- 2.4gHz Multi Protocol Radio
Certificated With
     FCC (USA)
     CE (Europe)
     TELEC (Japan)
     NCC (Taiwan)
     IC (Canada)
     SRRC (China)
     KC (South Korea)
     RoHS (International)

Working Distance Up to 60 meters in open space
CPU 32-bit ARM® Cortex™ M0 32-bit CPU
Memory 256/128KB embedded flash
RAM 32KB/16KB
System Peripherals
     3 x 16/24-bit timers with counter mode
     16 channel CPU independent Programmable Peripheral Interconnect (PPI)
     Encryption -128-bit AES ECB/CCM/AAR co-processor
     RNG, RTC, Temperature sensor
GPIO
     Flexible GPIO pin configuration, 31 GPIO, Up to 4 PWM
Digital I/O
     Digital interfaces -SPI Master/Slave, 2-wire, UART
     Quadrature decoder
Analog I/O
     8/9/10 bit ADC - 8 configurable channels
     Low power comparator
Oscillators
     16MHz XO, 16MHz RCOSC, 32MHx XO, 32kHz XO, 32kHz RCOSC
Power Management
     Wide supply voltage range (1.8v to 3.6V)
     Flexible power management scheme
     On-chip DC/DC converter
     600nA @ 3V OFF mode
     2.6µA @ 3V ON mode, all blocks in idle mode
     1.2µA @ 3V OFF mode + 1 region RAM retention

Real Time Clock DS3231MZ+
Features
-Highly Accurate RTC With Integrated MEMS Resonator Completely 
Manages All Timekeeping Functions
     - Complete Clock Calendar Functionality Including Seconds, Minutes, 
     Hours, Day, Date, Month, and Year, with Leap-Year Compensation 
     Up to Year 2100
     - Timekeeping Accuracy ±5ppm (±0.432 Second/Day) 
     from -45°C to +85°C
     - Footprint and Functionally Compatible to DS3231
     - Two Time-of-Day Alarms
     - 1Hz and 32.768kHz Outputs
     - Reset Output and Pushbutton Input with Debounce
     - Digital Temp Sensor with ±3°C Accuracy
     - +2.3V to +5.5V Supply Voltage
     - Simple Serial Interface Connects to Most Microcontrollers
          - Fast (400kHz) I2C Interface
     - Battery-Backup Input for Continuous Timekeeping
     - Low Power Operation Extends Battery-Backup Run Time
     - Operating Temperature Range: -40°C to +85°C
     - 8-Pin or 16-Pin SO Packages
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Charging IC MCP73831
Features
- High accuracy preset output voltage regulation (+/-0.75%)
- Output voltage options include 4.2V, 4.35V, 4.4V and 4.5V
- User-programmable charge current
- Charge status output can directly drive LEDs
- On-chip thermal regulation
- Preconditioning and end-of-charge ratio options
- Under-voltage lockout
Linear Mode Yes
Number of Cells 1
Int/Ext FET Int
Vcc Range (V) 3.75 to 6
Voltage Regulation Accuracy (%) 0.75
Max Thermal Regulation Yes

Barometric Pressure Sensor
Temperature Sensor BMP280
Features
Pressure Range 300 - 1100hPa (eqv. 9000m  to -500m)
Relative Accuracy ± 0.12hPa (eqv. ±1m) (950 to 1050hPa @25°C)
Absolute Accuracy ± 1hPa (950 to 1050hpa 0 to +40°C)
Temperature Coefficient Offset 1.5 Pa/K (25 to 40°C @900hPa)
Digital Interfaces I2C (up to 3.4mHz)
Current Consumption 2.7µA @1Hz sampling rate
Temperature Range -40 to +85°C 

Accelerometer
Gyroscope MPU6050
Features
Gyroscope
     - Digital-output X-, Y-, and Z-Axis angular rate sensors (gyroscopes) 
     with a user-programmable fullscale range of 
     ±250, ±500, ±1000, and ±2000°/sec
     - External sync signal connected to the FSYNC pin supports image, 
     video and GPS synchronization
     - Integrated 16-bit ADCs enable simultaneous sampling of gyros
     - Enhanced bias and sensitivity temperature stability reduces
     the need for user calibration
     - Improved low-frequency noise performance
     - Digitally-programmable low-pass filter

     - Gyroscope operating current: 3.6mA
     - Standby current: 5µA
     - Factory calibrated sensitivity scale factor
     - User self-test
Accelerometer
     - Digital-output triple-axis accelerometer with a programmable full
     scale range of ±2g, ±4g, ±8g and ±16g
     - Integrated 16-bit ADCs enable simultaneous sampling of 
     accelerometers while requiring no external multiplexer
     - Accelerometer normal operating current: 500µA
     - Low power accelerometer mode current: 10µA at
     1.25Hz, 20µA at 5Hz, 60µA at 20Hz, 110µA at 40Hz
     - Orientation detection and signaling
     - Tap detection
     - User-programmable interrupts
     - High-G interrupt
     - User self-test
Additional features
     - 9-Axis MotionFusion by the on-chip Digital Motion Processor (DMP)
     - Auxiliary master I2C bus for reading data from external sensors 
     (e.g., magnetometer)
     - 3.9mA operating current when all 6 motion sensing axes and the 
     DMP are enabled
     - VDD supply voltage range of 2.375V-3.46V
     - Flexible VLOGIC reference voltage supports multiple I2C interface 
     voltages
     - Smallest and thinnest QFN package for portable devices: 4x4x0.9mm
     - Minimal cross-axis sensitivity between the accelerometer and 
     gyroscope axes
     - 1024 byte FIFO buffer reduces power consumption by allowing 
     host processor to read the data in bursts and then go into a low-power 
     mode as the MPU collects more data
     - Digital-output temperature sensor
     - User-programmable digital filters for gyroscope, accelerometer, 
     and temp sensor
     - 10,000 g shock tolerant
     - 400kHz Fast Mode I2C for communicating with all registers
     - MEMS structure hermetically sealed and bonded at wafer level
     - RoHS and Green compliant
Motion processing
     - Internal Digital Motion Processing™ (DMP™) engine supports 
     3D MotionProcessing and gesture recognition algorithms
     - The MPU-60X0 collects gyroscope and accelerometer data while 
     synchronizing data sampling at a user defined rate. The total dataset 
     obtained by the MPU-60X0 includes 3-Axis gyroscope data, 3-Axis 
     accelerometer data, and temperature data. The MPU’s calculated 
     output to the system processor can also include heading data from 
     a digital 3-axis third party magnetometer.
     - The FIFO buffers the complete data set, reducing timing 
     requirements on the system processor by allowing the processor
     burst read the FIFO data. After burst reading the FIFO data, the 
     system processor can save power by entering a low-power sleep
     mode while the MPU collects more data.
     - Programmable interrupt supports features such as gesture 
     recognition, panning, zooming, scrolling, tap detection, and 
     shake detection
     - Digitally-programmable low-pass filters
     - Low-power pedometer functionality allows the host processor 
     to sleep while the DMP maintains the step count.
Clocking
     - On-chip timing generator ±1% frequency variation over full 
     temperature range
     - Optional external clock inputs of 32.768kHz or 19.2MHz
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3 Axis Magnetometer MAG3110
     Freescale’s MAG3110 is a small, low-power, digital 3-axis 
magnetometer.
     The device can be used in conjunction with a 3-axis accelerometer 
to realize an orientation independent electronic compass that can 
provide accurate heading information. It features a standard I2C 
serial interface output and smart embedded functions.
correspond to sample intervals from12.5 ms to several seconds.
     The MAG3110 is available in a plastic DFN package and it is 
guaranteed to operate over the extended temperature range 
of -40°C to +85°C.
Features
     - 1.95 V to 3.6 V supply voltage (VDD)
     - 1.62 V to VDD IO voltage (VDDIO)
     - Sensitivity of 0.10 µT
     - Output Data Rates (ODR) up to 80 Hz
     - Low-power, single-shot measurement mode

3 Axis Magnetometer MLX90393
     The MLX90393 brings the highest flexibility in the Triaxis portfolio's 
smallest packaged assembly. Additionally, the MLX90393 is designed 
for micropower applications, with programmable duty cycles in the 
range of 0.1% to 100% allowing for configurable power consumption 
based on system requirements.
Features
     - Selectable SPI and I2C bus protocols
     - On board filter settings
     - On the fly programmable operating modes and sleep times 
     for micro-power use
     - External and internal acquisition triggering modes
     - External interrupt pin enables waking a microcontroller 
     when the field changes
     - On board temperature sensor
     - RoHS compliant

Buzzer ST-0503-3
Features
Rated Voltage 3 V
Sound Pressure Output 10 dB @10 cm
Frequency 4000 Hz
Termination SMD

Voltage Regulator LP2985-33DBVR
Features
Output Tolerance %1.5
Ultra Low Dropout 280 mV @ 150 mA (full load) - 1 mV @ 1mA
Wide VIN Range 16 V Max
Low IQ 850 µA @ 150 mA (full load) 
Shutdown Current 0.01 µA
Low Noise 30 µVRMS  with 10-nF bypass capacitor
- Stable With Low-ESR Capacitors, Including Ceramic
- Overcurrent and Thermal Protection
- High Peak-Current Capability

Oled Display
Features
Diagonal Size 1.3”
Display Resolution 128 x 64 (~110PPI)
Active Area 29.42 mm x 14.7 mm
IC Driver SSD1306
Display Mode Passive Matrix
Display Color White
Drive Duty 1/64 Duty
Connection FPC Connector (0.5mm pitch)

LiPo Battery
Features
Nominal Voltage 3.7 V
Power Capacity 130 mAh
Number of Cells 1
- Onboard protection circuit
- Reverse coupling preventing connector design

for watchX V1.2

for watchX V1.3
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Chapter-3 Using the watchX
 The idea behind the watchX
 
 watchX has been developed to be an open, flexible and user-friendly platform as much as possible.
What to do with it? That is all up to the user. As developers we will give you the full access to use the watchX
hardware for you to bring your imagination to life. That’s why, we think that watchX is the next chapter in the
development community.
 Let’s start with the Arduino compatibility.  watchX is fully Arduino compatible and works with Arduino 
IDE. When you connect your watchX to your computer via USB cable, you computer will detect the watchX 
as an Arduino Leonardo development board. From that point on, all you have to do is download the Arduino 
IDE from www.watchx.io downloads section and start developing your own applications. You will find the 
necessary pin layout schemes and Arduino IDE explanations in the following pages of this manual.
 And for our Scratch users, you can download the mBlock and install our extension to it. Then you
can start programming right away. You will also find the detailed explanations for scratch in the following
pages.
 Last but not least, we also have developed a watch firmware for watchX. You can download our
firmware from GitHub and Compile&Upload it to your watchX using the Arduino IDE. Just follow the steps 
in the “Programming with Arduino IDE” section.
 From now on, you can develop your own applications or modify the others as you wish. The watchX
will be a perfect companion for you to learn and practice programming.
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 Pin Layout 
 According to MCU Atmega 32U4

Legend



13

 Pin Layout 
 According to Components

Oled Display

Bluetooth
NRF51822 Switches

Real Time Clock
DS3231MZ+

I2C Address 0x68

3 Axis Magnetometer
MAG3110 for watchX V1.2
MLX90393 for watchX V1.3

I2C Address 
0x0E for watchX V1.2
0x19 for watchX V1.3

Accelerometer
Gyroscope MPU6050

*ADO pin is connected to VCC
I2C Address 0x69

Barometric Pressure Sensor
Temperature Sensor BMP280

*SDO pin is connected to GND
I2C Address 0x76

Charging IC 
MCP73831

Circuit Diagram

Buzzer ST-0503-3
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 Pin Layout 
 According to Edge Connector

Do not solder on the edge connection contacts.
This may damage your watchX and it’s compatibility to the watchX accessories.
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 Programming the watchX with Arduino IDE

Step 1 - Download the Arduino IDE
 
 Go to www.arduino.cc and navigate to the Software/Downloads page. Download and install the suitable 
version of Arduino IDE to your operating system.

You can find more information and detailed instructions on how to install the Arduino IDE from;
For Linux:           https://www.arduino.cc/en/Guide/Linux
For MacOSX:     https://www.arduino.cc/en/Guide/MacOSX
For Windows:   https://www.arduino.cc/en/Guide/Windows

Step 2 - Download and install the watchX libraries

 The library files are modified in a way so that they can be used with watchX. Go to www.watchx.io 
and navigate to the Downloads page. Download the library files.
 Then, follow the library installation instructions from https://www.arduino.cc/en/Guide/Libraries use the
manual installation method.
 After this step, you are all set to write and upload your Arduino Sketches to watchX 

Step 3 - Upload an Arduino Sketch to watchX

 Connect the watchX to your computer via USB cable. Your computer must recognize the watchX as
an Arduino Leonardo. That is normal because watchX uses Arduino Leonardo bootloader.
 Go to Tools -> Port and select the port that the watchX is connected.
 Go to Tools -> Board and select Arduino Leonardo.
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 Now, you are ready to upload any sketch you like to watchX. You can use the pin layout provided for
hardware control. You can check and modify the examples published on the downloads page of watchx.io
And you can download the watchX Firmware from GitHub and upload it to your watchX.

 Programming the watchX with Scratch IDE (using mBlock)
 mBlock is the one of the most used Scratch IDE, it is well recognized, easy to use and easy to develop
the extensions for. That’s why we based our Scratch compatibility on mBlock. Follow the steps below and
explore the easy drag&drop environment of Scratch programming. 

Step 1 - Download the mBlock
 
 Go to www.makeblock.com and navigate to the Software/Downloads page. Download and install the 
suitable version of mBlock3 to your operating system.

Step 2 - Download and install the watchX extension

 The mBlock extension for watchX is designed so that users can easily harness the power of watchX
without getting into much detail. There are two ways to add extensions on mBlock. You can either add the 
extension manually or you can use the Extension Manager’s search tool and load the extension automacily.
 For manual extension adding, download the watchX extension for mBlock, from the downloads section 
of www.watchx.io.

a) Open the Manage Extension window 
from the Extensions menu

b) To make an online extension load, search watchX
from the search bar section and download&add the
watchX extension. To add the extension manually,
click the Add Extension button. 
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c ) Choose the filetype as .zip from the selection window 
and select the extension file you have downloaded.

Step 3 - Upload a Scratch program to watchX

 Connect the watchX to your computer via USB cable. Your computer must recognize the watchX as
an Arduino Leonardo. That is normal because watchX uses Arduino Leonardo bootloader.
 Carry on the following steps.

a ) Select Arduino mode from the Edit menu.

b ) Select the port watchX is connected from 
the Connect menu.

c ) Select the Arduino Leonardo option from
the Boards menu.

 You have successfully set the mBlock for watchX. Now you can construct your program and upload
it to watchX by simply clicking the Upload button.
 You can also find the detailed explanation and documents of watchX blocks and how to use them
from www.watchx.io downloads section. 
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watchX doesn’t turn on

Battery connection

Battery charge level

No program loaded to watchX

- Check if the battery is connected
to watchX properly and check the
cables whather they are damaged
or not.

(If the battery cables are damaged,
pay extreme care and do not shot
the poles together. If you need to
change the battery, always dispo-
se the old battery with respect to
environment.)

- Check if the battery is charged or
not. If the battery is not charged,
connect the watchX to a USB pow-
er source with the given cable.

- Connect your watchX to your
computer and upload a program
to it by following the steps expla-
ined in the Chapter 3.

Battery is not charging

Battery connection

Weak power source

Poor quality USB cable

Dead battery

- Check if the battery is connected
to watchX properly and check the
cables whether they are damaged
or not.

(If the battery cables are damaged,
pay extreme care and do not shot
the poles together. If you need to
change the battery, always dispo-
se the old battery with respect to
environment.)

- Check if your power source is su-
pplying enough power.

- Use the cable given with watchX

- The battery might be dead, re-
place the battery.
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I can’t upload a program

Poor quality USB cable

Wrong Arduino IDE settings

Wrong Scratch IDE settings

- Use the cable given with watchX

- Check the Arduino IDE settings,
make sure that you have selected
the correct port and the correct
board type. Make sure that you
have loaded the watchX libraries
correctly. 

- Check the Scratch IDE settings,
make sure that you have selected
the correct port and the correct
board type. Make sure that you
have loaded the watchX extension
correctly. 

I can’t connect via Bluetooth

Bluetooth is not turned on

Bluetooth App is outdated

The program running on watchX
is not written correctly

- Make sure that the Bluetooth is
enabled on your mobile device. 
If the problem continues restart
your device.

- The Bluetooth App on your dev-
ice might be an older version. Make
sure that you are using an up to
date version.

- Check your program uploaded to 
watchX. Make sure that it is cor-
rectly written and there are no
mistakes in the sketch.  

Display is not working

Oled FFC cable is not connected
properly

The program running on watchX
is not written correctly

- Make sure that the Oled FFC
cable is connected properly. Check
the steps explained in the Chapter1

- Check your program uploaded to 
watchX. Make sure that it is cor-
rectly written and there are no
mistakes in the sketch. 

There could be some other problems that you might be facing.
You can always contact: support@argex.io



Chapter-5 Safety and warranty
Safety
Read and understand the users manual carefully before using watchX.

Caution: Do not try to modify or fix watchX. The watchX is not user
serviceable.
Caution: Use the watchX with caution and in accordance with local
traffic regulations.
To avoid the risk of injury or damage, always follow these basic 
precautions.
Only use the watchX in accordance with the specifications outlined
in this manual and on www.watchx.io
Do not attempt to repair or adjust any electrical or mechanical
functions of this device. Tempering with these conditions may create
a hazardous condition and will void your warranty.
 
Use restrictions
Do not temper or abuse your watchX including, without limitation,
do not drop, disassemble, puncture, crush, throw, glue, paint or deform
your watchX.
Prevent the watchX from getting in contact with any kind of liquid or
moisture.
Do not clean your watchX with any kind of wet towel or hot air source.
Do not blow pressurized air on to the watchX.
Do not try to remove any electronic component from watchX board and
do not solder on watchX PCB. This will void your warranty.
Do not place watchX near open flames or excessive heat, such as
candles, fireplaces or cooktops.
Do not bring sharp objects in contact with the watchX to avoid 
scratches and damage.
Avoid temperatures below -10C/14F and above 50C/122F.

Battery and charging
Only use the battery supplied with watchX.
Only replace the watchX battery with an original watchX battery.
Do not tamper with the battery.
Do not drop, crush throw paint, glue, puncture or deform the battery.
Do not make any modifications to the battery.
Do not make any solder on the battery. This may create hazardous
conditions.
Do not tamper with, or make any modifications to the battery cables 
and the battery connectors located on the watchX PCB and connected 
on the battery cable.
Only use the charging cable supplied with the watchX.
Do not use 3rd party charging cables.
Only charge with USB Compliant ports and chargers.
Only program your watchX with USB Compliant ports.
Do not charge the watchX if it’s wet.
Do not clean your watchX when it’s being charged.
Do not dispose the watchX battery into fire. It may explode an can 
cause injury.

Medical Device Interference
watchX contains components and radios that emit electromagnetic
fields. Maintain a safe distance of separation between your medical
device and the watchX. If you suspect any kind of interference with
your pacemaker or any other medical device, stop using the watchX
Consult this condition with your physician/doctor and medical device
manufacturer.
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Warranty
argeX warrants that it’s products will conform to the specifications. The 
warranty lasts for one (1) year from the date of purchase. argeX will not be 
liable for any defects that are caused by neglect, misuse or mistreatment by 
the customer. Including improper setup or testing, or any products that have 
been altered or modified in any way by the customer. Moreover, argeX will 
not be liable for any defects that result from the customer’s design or setup.

If any of the argeX products fail to conform to the warranty set forth above,
argeX’s sole liability will be to replace such products. argeX’s liability is limited 
to the products that are determined by argeX not to conform such warranty. 
If argeX elects to replace such products, argeX has to have a reasonable time 
to provide replacements. Replaced products will be warranted for the one (1) 
year from the date of purchase.

EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED “AS IS” AND
“WITH ALL FAULTS”. argeX DISCLAIMS ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE.

The customer agrees that prior to using any systems that include argeX 
products, the customer will test such systems and the functionality of the 
products as used in such systems. argeX may provide technical, applications 
or design advice, quality characterization, reliability data or other services. 
The customer acknowledges and agrees that providing these services will 
not expand ot otherwise alter argeX’s warranties, as set forth above, and 
that no additional obligations or liabilities will arise from argeX providing 
such services.

argeX products are not authorized for use of safety-critical applications 
where a failure of the argeX product would reasonably be expected to cause
severe personal injury or death. Safety-critical applications include, without 
limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapon systems. argeX products are 
neither designed nor intended for use in military or aerospace applications 
or environments, nor for automotive applications or the automotive 
environment. The customer acknowledges and agrees that any such use of 
argeX products are solely at the customer’s risk, and the customer is sole 
responsible for the compliance of all legal and regulatory requirements in 
connection with such use.

The customer acknowledges and agrees that the customer is the sole 
responsible for complience with all legal, regulatory and safety-related 
requirements concerning the products and any use of argeX products in the 
customer’s applications, notwithstanding any applications related information 
or support that may be provided by argeX. 

Changes to specifications
argeX may make changes to specifications and product descriptions any time, 
without notice. The product information on the website or materials is subject 
to change without notice.

Regional disposal and recycling
information

This symbol indicates that this product and/or battery should not be disposed 
of with household waste. When you decide to dispose of this product and/or 
its battery, do so in accordance with local environmental laws and guidelines. 
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